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You can install the add-on from GitLab releasesDownload the xpi-file (from latest release), go to downloads and install the add-on.Or go to Tools > Add-ons (about:addons) > Extensions > Settings/Cogwheel - Install Add-on from FileCustom xpi-file has host permissions for all sites.Minumum browser requirement: Firefox 86+.If you want to
permanently install the latest master ZIP-file from GitLab (with post-release fixes) use a Firefox browser which allows using unsigned add-ons like Firefox Developer Portable (go to about:config and set xpinstall.signatures.required to false) or LibreWolf (for both no automatic updates of add-on).Or load a temporary add-on in regular Firefox (go to
about:debugging#/runtime/this-firefox & load manifest.json from unpacked (master-zip) folder.By default BPC has limited host permissions, but you can opt-in to enable custom sites (and also clear cookies/block general paywall-scripts for unlisted sites). You can also just request permissions for the custom sites you added yourself (or click clear
cookies (BPC-icon) to ask for permission for current site).You can also install the custom add-on version (with host permissions for all sites). Add-on will automatically update or you can do a manual check for updates (in about:addons).Either way you have to allow host permissions for newly supported sites (else no update will be installed).You can
also check for update of site rules at startup (opt-in); only available until about 10 days after fix-release.For new sites you also have to opt-in to custom sites/request permissions for new domains (or wait for new release). Add-on was removed by Mozilla from add-on store.Current installations (by custom collection in Firefox Beta/Nightly or Firefox-
clone) will stay active, but with no more updates.There is still an elaborate workaround for regular Firefox (or Beta/Clone) though:install an old version of Firefox (like v68.11.0 from archive.mozilla.org or apkmirror.com); first you have to remove your current Firefox appfor the add-on you can also use Firefox Beta or a Firefox clone like Fennec F-
Droid where you can set a custom add-on collection; again first install an old version of Firefox Beta v68.7 or Fennec F-droid v68.11.0download add-on's xpi-file (custom version if you want to use custom sites) from releases and install/open in Firefoxnow you can update Firefox to the latest versionadd-on will stay active & automatically updates to the
latest versionin add-ons it will be labeled as not yet available and also has no more option to enable the add-on in private browsingThe experimental Mozac/GeckoView-based browser SmartCookieWeb-Preview can also install/sideload a xpi-file by url (Settings > Advanced settings > Sideload XPI).No option to enable the add-on in private browsing
though.Or switch to Kiwi browser (Chromium) or use the adblocker filter/userscripts Visit the Chrome repository of Bypass Paywall Clean. Use adblocker with custom (content)filter & userscript (manager): If a site doesn't work, first try to turn off your adblocker (or other extension) and refresh page.Make sure the (new) site is checked under
Options.Clear cookies by add-on's icon and grant permission for site (or opt-in to custom sites)You will be logged out for most of the sites you have enabled.Make sure you're running the latest version of Bypass Paywalls Clean.Some sites need to redirect to an amp-page (add an exception in your Redirect AMP to HTML or DuckDuckGo Privacy
Essentials add-on).If none of these work, you can submit an issue.This add-on works best alongside the adblocker uBlock Origin.If you live in the EU, also consider adding these filters to your adblocker (in order to remove cookie warnings): Easylist Cookies | I don't care about cookies custom filter. Some sites need to set a consent-cookie for (social)
media. * free articles only. Foreign Affairs -Foreign Policy -Inkl -Newsweek -Reuters -Stratfor -The New York Times -The Washington Post -Time Magazine Adweek* -American Affairs -American Banker -Barron's -Bloomberg -Business Insider -CNBC -Digiday -Forbes -Fortune -Harvard Business Review -Inc.com -Law.com* -MarketWatch -MIT Sloan
Management Review -Quartz -S&P Global -Seeking Alpha -Stock News -The Business Journals* -The Business of Fashion -The Wall Street Journal -Vogue Business -ZeroHedgeGrouped in options:California Business Journals sites likeL.os Angeles Business Journal -Orange County Business Journal -San Diego Business Journal -San Fernando Valley
Business JournalCrain Communications sites likeAd Age -Automotive News -Crain's Chicago Business -Crain's Cleveland Business -Crain's Detroit Business -Crain's New York Business -Modern HealthcarePEI Media sites (opt-in to custom sites) Bulletin of the Atomic Scientists -Chemical & Engineering News -Discover Magazine -Inside Higher Ed -
Medscape -MIT Technology Review -National Geographic USA -Nautilus -New Scientist -Popular Science -Science* -Scientific American -Times Higher Education -VentureBeatGrouped in options:GenomeWeb sites like360Dx -GenomeWeb -Precision Oncology NewsThe Chronicle sites likeThe Chronicle of Higher Education -The Chronicle of
Philanthropy BBC History Extra -Encyclopedia Britannica -eNotes -Glassdoor -Loeb Classical Library -Philosophy Now -Quora -SlideShare -Statista -StuDocu ESPN USA -RugbyPass -Sports Illustrated -The Athletic MediumSubstack (link to Google Search Tool; opt-in to custom sites for custom domains)Grouped in options:Medium custom domains like
(opt-in to custom sites for unlisted)Better Programming -Towards Data ScienceApollo Magazine -Artforum -Artnet -Atavist Magazine -Axios -Commentary Magazine -Defector -Field & Stream -First Things -Harper's Magazine -National Review -Outdoor Life -Project Syndicate (link to archive.is) -Puck.news -Slate -SofRep -The American Interest -The Art
Newspaper -The Atlantic -The Christian Science Monitor -The Intercept -The Daily Beast -The Daily Wire -The Juggernaut -The Nation -The New Atlantis -The New Republic -The New York Review of Books -The Point Magazine -The Spectator World -The WrapGrouped in options:Cond Nast magazines sites likeArchitectural Digest -Bon Apptit -
Epicurious -GC -The New Yorker -Vanity Fair -Vogue USA -WiredHearst Communications magazines sites likeBicycling -Cosmopolitan -Country Living -Elle USA -Esquire -Good Housekeeping -House Beautiful -Men's Health -Popular Mechanics -Prevention -Road & Track -Runner's World -The Hollywood Reporter -Town & Country -Women's
HealthMadavor Media sites (opt-in to custom sites)Outside magazines sites likeBackpacker -Beta -Better Nutrition -Clean Eating -Climbing -Cycling Tips -Gym Climber -Outside -Oxygen -Peloton -Podium Runner -Rock and Ice -SKI -Trail Runner -Triathlete -Vegetarian Times -Velo News -Women's Running -Yoga JournalPenske Media Corporation sites
likeBillboard -Rolling Stone -Sportico -Variety -WWD Albuquerque Journal -Honolulu Star-Advertiser -Los Angeles Times -Mountain View Voice -New York Magazine (+ Curbed, Grub Street, The Cut & Vulture) -Newsday -Palo Alto Online -Pittsburgh Post Gazette -San Diego Union Tribune -Star Tribune -Tampa Bay Times -The Advocate -The Atlanta
Journal-Constitution -The Boston Globe -The Dallas Morning News -The Hill -The New Orleans Advocate/The Times-Picayune -The New York Post -The New York Sun -The Seattle Times -The Philadelphia InquirerUSA TodayGrouped in options:Advance Local sites likeAL/Alabama -MLive/Michigan -NJ/New Jersey -Staten Island Advance -The Express-
Times -The Oregonian -The Patriot-News -The Plain Dealer -The Post-Standard -The RepublicanGannett Group (local USA Today) sites like (opt-in to custom sites for unlisted)Austin American-Statesman -Democrat and Chronicle -Detroit Free Press -Knoxville News Sentinel -Memphis Commercial Appeal -Milwaukee Journal Sentinel -The Arizona
Republic -The Cincinnati Enquirer -The Courier-Journal -The Detroit News -The Indianapolis Star -The News-Press -The Oklahoman -The Record (North Jersey) -The TennesseanHearst Communications (newspapers) sites like (opt-in to custom sites for unlisted)Houston Chronicle -San Antonio Express-News -San Francisco ChronicleLee Enterprises
Group sites like (opt-in to custom sites for unlisted)Arizona Daily Star -Omaha World-Herald -Richmond Times-Dispatch -The Buffalo News -Tulsa World -Winston-Salem JournalMcClatchy Group sites like (opt-in to custom sites for unlisted)Belleville News-Democrat -Fort Worth Star-Telegram -Lexington Herald-Leader -McClatchy DC -Miami Herald -
The Charlotte Observer -The Fresno Bee -The Kansas City Star -The News & Observer -The Sacramento Bee -The State -The Wichita Eagle -Tri-City HeraldMediaNews Group sites like (opt-in to custom sites for unlisted/local sites)East Bay Times -Orange County Register -St. Paul Pioneer Press -The Denver Post -The Mercury News -The Press-
EnterpriseTownNews sites (Blox CMS) sites (opt-in to custom sites)Tribune Publishing Company sites likeBaltimore Sun -Capital Gazette -Chicago Tribune -Daily Press -Hartford Courant -New York Daily News -Orlando Sentinel -SunSentinel -The Morning Call -The Virginian-Pilot iPolitics -Le Devoir -Saltwire Network -The Globe and Mail -The Hill
Times -The Lawyer's Daily -Winnipeg Free PressGrouped in options:Groupe Capitales Mdias sites like (opt-in to custom sites for unlisted)Le SoleilPostmedia Network sites like (opt-in to custom sites for unlisted)Calgary Herald -Financial Post -National Post -The Province -Toronto Sun -Vancouver SunTorStar sites likeThe Toronto Star and regional
sitesNiagara Falls Review -Peterborough Examiner -St. Catharines Standard -The Hamilton Spectator -Waterloo Region Record -Welland Tribune Bloomberg Adria -EUobserver Belfast Telegraph -Business Post -Citywire -Euromoney -Evening Standard -Financial News -Financial Times -iNews -Investors' Chronicle -Irish Independent -London Review of
Books -New Left Review -Private Equity News -Prospect Magazine -Tes Magazine -The Banker -The Critic -The Economist -The Independent -The Irish Times -The New European -The New Statesman -The Spectator -The Telegraph -The Times (link to archive.is) -The Times Literary Supplement -UnHerdGrouped in options:National World Publishing
sites like (opt-in to custom sites for unlisted)The Scotsman -Yorkshire Post Berlingske Suomen Sotilas 60 Millions de consommateurs -Alternatives Economiques -Atlantico -Auto Plus -Causeur -Challenges -Charlie Hebdo -Connaissance des Arts -Elle -Esprit -Franc-Tireur -L'cho -L'Express -L'Humanit -L'Inform -L'Obs -L'Oeil de la Photographie (fr/en) -
L'Usine Nouvelle -La Croix -La Nouvelle Rpublique du Centre-Ouest -La Tribune -Le Courrier des Stratges -Le Figaro (link to archive.is) -Le Grand Continent -Le Journal du Dimanche -Le Journal du Net -Le Nouvel Economiste -Le Parisien -Le Point -Le Tlgramme -Les chos -Les Inrockuptibles -Marianne -Paris Match -Philosophie Magazine -Public -
Revue Conflits -Science & Vie -Sciences et Avenir -Tlrama -Valeurs ActuellesGrouped in options:Groupe Centre France sites like (opt-in to custom sites for unlisted)La MontagneGroupe EBRA sites likeDernires Nouvelles d'Alsace -L'Alsace -L'Est Rpublicain -Le Bien Public -Le Dauphin Libr -Le Journal de Sane-et-Loire -Le Progrs -Le Rpublicain Lorrain
-Vosges MatinGroupe IPM sites likeDH Les Sports+ -L'Avenir -La LibreGroupe La Dpche sites likeCentre Presse -L'Indpendant -La Dpche du Midi -La Nouvelle Rpublique des Pyrnes -Le Petit Bleu d'Agen -Midi Libre -Midi OlympiqueGroupe Nice-Matin sites likeMonaco-Matin -Nice-Matin -Var-MatinGroupe Rossel sites likeL'Aisne nouvelle -L'Ardennais
-L'Est-clair -L'Union -La Voix du Nord -Le Courrier picard -Le Soir -Libration Champagne -Nord Littoral -Paris Normandie -SudInfoGroupe Sud Ouest sites likeCharente libre -La Rpublique des Pyrnes -Sud OuestRoularta Media Group sites likeFemmes d'Aujourd'hui -Flair.be -Le Vif Allguer Zeitung -rzte Zeitung -Augsburger Allgemeine -
Automobilwoche -Badische Neueste Nachrichten -Berliner Zeitung -Cicero -Der Spiegel (link to archive.is) -Der Tagesspiegel (link to archive.is) -Deutsches rzteblatt -Die Zeit -Frankfurter Allgemeine Zeitung -Freie Presse -Jacobin Magazin -Klner Stadt-Anzeiger -Klnische Rundschau -Krautreporter -Kurier.at -Mitteldeutsche Zeitung -Neue Westflische -
Philosophie Magazin -Piqd -Rhein-Zeitung -Schwbische Zeitung -Sddeutsche Zeitung (link to archive.is) -Volksstimme -Weltkunst -Westdeutsche ZeitungGrouped in options:Deutscher Fachverlag Mediengruppe (opt-in to custom sites)Funke Mediengruppe sites like (opt-in to custom sites for unlisted)Berliner Morgenpost -Braunschweiger Zeitung -
Hamburger Abendblatt -Neue Ruhr Zeitung -Ostthringer Zeitung -Thringer Allgemeine -Thringische Landeszeitung -Westdeutsche Allgemeine Zeitung -Westfalenpost -Westflische RundschauHaas Mediengruppe sites (opt-in to custom sites)Landwirtschaftsverlag sites likeProfi.de -Top Agrar.at -Top Agrar.com -Wochenblatt fr Landwirtschaft &
LandlebenMadsack Mediengruppe sites like (opt-in to custom sites for unlisted)Hannoversche Allgemeine Zeitung -Kieler Nachrichten -Leipziger Volkszeitung -Lbecker Nachrichten -Mrkische Allgemeine -Neue Presse (Hannover) -Ostsee-Zeitung -RedaktionsNetzwerk DeutschlandMedienhaus Aachen sites likeAachener Nachrichten -Aachener
ZeitungNOZ/MHN Mediengruppe sites likeNeue Osnabrcker Zeitung -Schleswig-Holsteinischer Zeitungsverlag -Schweriner VolkszeitungVerlagsgruppe Rhein Main sites like (opt-in to custom sites for unlisted)Allgemeine Zeitung (Mainz) -Darmstdter Echo -Wiesbadener KurierWestflische Mediengruppe sites likeMnstersche Zeitung -Westfalen-Blatt -
Westflische Nachrichten Corriere della Sera -Corriere dello Sport -Domani -Eastwest -I1 Fatto Quotidiano -I1 Foglio -1l Manifesto -I1 Tirreno -Internazionale -Italia Oggi -La Gazzetta dello Sport -La Nuova SardegnaGrouped in options:Gruppo GEDL.it sites likeltalian.tech -L'Espresso -Le Scienzell Messaggero and regional sites likeCorriere Adriatico -I1
Gazzettino -I1 Mattino -Quotidiano di PugliaQuotidiano Nazionale and regional sites likeIl Giorno -I1 Resto del Carlino -Il Telegrafo Livorno -La Nazione De Limburger -De Tijd -Financieele Dagblad -Follow the Money -Groene Amsterdammer -NRC Handelsblad -Telegraaf -Vrij NederlandGrouped in options:Algemeen Dagblad (+ regional; link to
archive.is) sites likeAlgemeen Dagblad -BN DeStem -Brabants Dagblad -Eindhovens Dagblad -Gelderlander -PZC -Stentor -TubantiaDPG Media (not ADR) sites likeDe Morgen -De Volkskrant -Flair.nl -Humo -Libelle.nl -Margriet -Parool -TrouwMediahuis Nederland Regional sites likeNoordhollands Dagblad -Haarlems Dagblad -Leidsch Dagblad -
IJmuider Courant -De Gooi- en EemlanderMediahuis Noord sites like (opt-in to custom sites for unlisted)Dagblad van het Noorden -Leeuwarder CourantProMedia Group sites (opt-in to custom sites)Roularta Media Group sites likeArtsenkrant -Flair.be -Knack -Krant van West-Vlaanderen -Libelle.be DNGrouped in options:NHST Media Group sites
likeEuropower -Fiskeribladet -Intrafish -Intrafish.no -Recharge -TradeWinds -Upstream Correio da Manh -Observador -Record Wonderzine El Confidencial -El Diario.es -El Espaol -El Pas -El Peridico de Catalunya -La Vanguardia -Mundo Deportivo -Poltica ExteriorGrouped in options:ARA sites likeAra.cat -Ara BalearsGrupo Prensa Ibrica sites like (opt-
in to custom sites for unlisted)Diario de Mallorca -El Da -El Peridico de Espaa -Faro de Vigo -Informacin -La Nueva Espaa -La Provincia -Levante-EMYV -Mallorca ZeitungGrupo Unidad Editorial sites likeEl Mundo -Expansin -MarcaGrupo Vocento sites likeABC -Diario Vasco -El Comercio -El Correo -El Diario Montas -El Norte de Castilla -Hoy -Ideal -La
Rioja -La Verdad -La Voz de Cdiz -Las Provincias -SurSport Life Ibrica sites (opt-in to custom sites) Aftonbladet -Dagens ETC -Dagens Industri -NyTeknik ArcInfo -Beobachter -Handelszeitung -Neue Zrcher Zeitung (+ regional/CH Media; opt-in to custom sites) -Tages-Anzeiger (link to archive.is) -The Market Eureka Report -Intelligent Investor -New
Zealand Herald -Quillette (link to archive.is) -The Saturday Paper -The Spectator Australia -The West Australian (+ regional/opt-in to custom sites)Grouped in options:Australia News Corp sites likeCode Sports -Gold Coast Bulletin -Herald Sun -Northern Territory News -The Advertiser/AdelaideNow -The Australian -The Chronicle -The Courier-Mail -
The Daily Telegraph -The Mercury Tasmania -The Weekly TimesAustralia Nine Entertainment sites likeBrisbane Times -The Age -The Australian Financial Review -The Sydney Morning Herald -WAtodayAustralian Community Media (daily) sites like (opt-in to custom sites for unlisted)Bendigo Advertiser -Central Western Daily -Daily Liberal -Illawarra
Mercury -Newcastle Herald -The Advocate -The Border Mail -The Canberra Times -The Courier -The Daily Advertiser -The Examiner -The Northern Daily Leader -The Standard -Western Advocate CommonWealth Magazine Taiwan* -Harvard Business Review China -Initium Media -Mainichi Shimbun -Nikkei Asian Review -NK News -South China
Morning Post -Southern Weekly -Tech in Asia -The Diplomat -The Japan Times -The Star Malaysia BQ Prime -Hindustan Times -Inc42 -India Today -Live Law -LiveMint -Mid-Day -Outlook -Outlook Business -The Economic Times (ET Prime) -The Financial Express -The Hindu -The Hindu BusinessLine -The Indian Express -The Quint -Times of India Globes
-Haaretz.co.il -Haaretz.com -The Jerusalem Post -The Marker mbito -La Nacin*Grouped in options:Grupo Clarn sites likeClarn -La Voz del Interior -Los Andes Estado de Minas -Exame -Grupo Abril -O Estado de S. Paulo -O Globo -Valor EconmicoGrouped in options:UOL sites likeCruso -Folha de S. Paulo -UOL Diario Financiero -E1 Mercurio (+
regional/opt-in to custom sites) -La Segunda -La Tercera El Espectador -El Tiempo Mexico News Daily Grupo El Comercio sites likeDiario Correo -El Comercio -Gestin El Observador -El Pas -La Diaria* free articles only. The free article limit can normally be bypassed by removing cookies for the site.Click on the BPC-icon and then 'clear cookies'-button
in the popup (for unsupported sites grant permission for domain).If removing the cookies works you can also add the site as a custom site. You can submit a request for a new website.Please use the issue template (check READ FIRST issue), read the following instructions and share your results for a quicker process.Remember to check the previous
requests before asking for a new website.Open incognito window and search for article in Google search (or webcache).Clear cookies for the site (by this add-on: opt-in to custom sites or grant permission for the site; also enables blocking of general paywall scripts).Disable Javascript on the site (by browser, uBlock Origin or other add-on).Add the
domain as custom site for more bypass options.Open page in reader view (by browser or add-on).Try one of the archive sites (for Google Search Tool copy html (tab) code to ). Add your own custom site (also for testing).Check 'Options'-link in popup-menu and go to custom sites.* by default BPC has limited permissions, but you can opt-in to enable
custom sites (and also clear cookies/block general paywall-scripts for unlisted sites). You can also just request permissions for the custom sites you added yourself (or clear cookies (BPC-icon) to ask for permission for current site).By default sites' cookies/local storage are blocked/removed (for example to bypass article limit when metered
paywall).Additional custom options:allow/remove cookies (no options selected: cookies are blocked)set useragent to Googlebot, Bingbot or Facebookbotset referer (to Facebook, Google or Twitter; ignored when Googlebot is set)set random ip-addressdisable Javascript for (sub)domain(s), external domains (when host permission) and/or inline
scriptsblock regular expression (to block specific script and/or xhr)unhide text amp-pageredirect to amp-page when paywall(selector)load text from json when paywall|article(selector)load text from Google webcache when paywall|article(selector)add external link to archive-site when paywall|article(selector)remove/unhide elements in dom (optional
for dev; check examples)Example list of custom sites or download list (json) Add excluded sites/domains (for your subscriptions).You can also exclude a specific domain which is grouped in options. Visit the changelog page.Or check the commits.Download the latest versionBypass Paywalls Clean is MIT-licensed.This software is provided for educational
purposes only and is provided "AS IS", without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement. In no event shall the authors or copyright holders be liable for any claim, damages or other liability, whether in an action of contract, tort or
otherwise, arising from, out of or in connection with the software or the use or other dealings in the software. You cant perform that action at this time. CastleBlock is a browser extension designed to help users effortlessly bypass paywalls on certain websites. By simply clicking on the CastleBlock icon in your browser toolbar, the extension leverages
its magic to redirect the current webpage to a version without the pesky paywall restrictions. It's your trusty companion for freely accessing content that may be behind subscription or payment barriers. onlineAdd-on allows you to read articles from (supported) sites that implement a paywall. You can also add a domain as custom site and try to bypass
the paywall. Weekly updates are released for fixes and new sites. InstallationDownload the latest release by xpi-file from GitFlic, go to downloads and install the add-on (or drag it from your file-manager anywhere on a page/tab in Firefox). You can also go to Tools > Add-ons (about:addons) > Extensions > Settings/Cogwheel - Install Add-on from
FileBy default BPC has limited host permissions, but you can opt-in to enable custom sites (and also clear cookies/block general paywall-scripts for unlisted sites). Or just request host permissions for the custom sites youve added yourself (or click clear cookies (BPC-icon) to ask for host permission for current site). You can also install the custom add-
on version (with host permissions for all sites).For easier access to the add-on options/settings you can add/pin the add-on icon to the toolbar with the toolbar extensions menu (jigsaw puzzle shaped icon). Minimum browser requirement: Firefox 86+.PS although the add-on was removed from Mozillas add-on store (AMO) (because of DMCA Takedown
Notice) its still signed and manually checked for security by Mozilla (hence the delay in signing).If you want to permanently install the latest master zip-file from GitFlic (with post-release fixes) use a Firefox browser which allows using unsigned add-ons like Firefox Developer Portable (go to about:config and set xpinstall.signatures.required to false)
or LibreWolf (for both no automatic updates of add-on). You also need to repack the zip-file so it doesnt contain a folder (default on sites like GitHub).Or load a temporary add-on in regular Firefox (go to about:debugging#/runtime/this-firefox & load manifest.json from unpacked (master-zip) folder).UpdateAdd-on will automatically update or you can
do a manual check for updates (in about:addons). Either way you have to allow host permissions for newly supported sites (else no update will be installed). You can also check for update of site rules at startup (opt-in); only available until about 10 days after fix-release. For new sites you also have to opt-in to custom sites/request host permissions for
new domains (or wait for new release).AndroidAdd-on was removed by Mozilla from the add-on store (AMO).With Firefox 122+ (& Android 10+) you can still install/sideload this add-on by downloading xpi-file of latest release from GitFlic (with automatic add-on updates) when you enable the debug menu (settings > about > tap Firefox logo 5 times >
return to settings): youll get new menu item Install extension from fileOr use the Firefox-fork Iceraven v2.13.2+ (manual add-on updates). You can install/update Iceraven manually or use the app FFUpdaterOr switch to Quetta Browser (Chromium). You can also use the adblocker filter/userscripts (much less supported sites).Chrome/ChromiumVisit
the Chrome repository on GitFlic of Bypass Paywalls Clean. Or manually install latest release by zip or crx-file from GitFliciOS/iPadOSUse adblocker with custom (content)filter & userscript (manager): Bypass Paywalls Clean filters (read instructions).Although Orion Browser supports installing this add-on, it wont work for a lot of sites (no full support
of WebExtensions API on i0S/iPadOS).Troubleshooting If a site doesnt work, first try to turn off your adblocker (or other extension) and refresh page. Make sure the (new) site is checked under Options (or not in no-fix list when you search the domain). Clear cookies by add-ons icon (popup) and grant host permission for site (or opt-in to custom sites)
You will be logged out for some of the sites you have enabled. Make sure youre running the latest version of Bypass Paywalls Clean. archive.is/today will not work with Secured DNS by Cloudflare (or when you change referer/user-agent for the archive site) for Google Search/Inspection Tool test url, view tested page, copy html (tab) code to & Open in
New Window: click BPC icon once to clean layout of page (or use tool for desktop & open screenshot in new tab) Some sites need to redirect to an amp-page (this may cause a redirect-loop by an amp-to-html add-on or browser setting). If none of these work, you can submit an issue on GitHub or only when GitHub repo is offline use X (DM). Always
provide used add-on version, paywalled article (url) and describe issue in detail. This add-on works best alongside the adblocker uBlock Origin. If you live in the EU, also consider adding these filters to your adblocker (in order to remove cookie warnings): Easylist Cookies | I dont care about cookies custom filter. Some sites need to set a consent-
cookie for (social) media.Go to topList of supported websites* free articles only.National USA newsReuters - The New York Times - The Washington PostBusinessAdweek - American Affairs - Barrons - Benzinga - Bloomberg - Business Insider - Citywire - CNBC - Fast Company - Forbes - Fortune - Harvard Business Review - Inc.com - MarketWatch - MIT
Sloan Management Review - Quartz - S&P Global - Stock News - The Business Journals* - The Business of Fashion - The Wall Street Journal - Vogue Business - ZeroHedgeGrouped in options:American Banker (+ Arizent; opt-in to custom sites)BNP Media sites (opt-in to custom sites)Bridge Tower Media sites (opt-in to custom sites)California Business
Journals sites likeL.os Angeles Business Journal - Orange County Business Journal - San Diego Business Journal - San Fernando Valley Business JournalCrain Communications sites likeAd Age - Automotive News - Crains Chicago Business - Crains Cleveland Business - Crains Detroit Business - Crains Grand Rapids Business - Crains New York Business -
Modern Healthcare - Pensions & Investments Global Polymer Group: European Rubber Journal - Plastics News - Rubber News - Sustainable Plastics - Tire Business - Urethanes Technology InternationalDigiday Media sites likeDigiday - Glossy - ModernRetaillndustry Dive sites (opt-in to custom sites)Inside Retail sites (opt-in to custom sites)PEI Media
sites (opt-in to custom sites)Tech/ScienceBrill - Bulletin of the Atomic Scientists - Chemical & Engineering News - Discover Magazine - History Today - Inside Higher Ed - Interesting Engineering - Medscape - MIT Technology Review - National Geographic USA - Nature - Nautilus - New Scientist - Popular Science - Science* - ScienceNews.org -
Scientific American - StatNews - The Scientist - Times Higher EducationGrouped in options:Crain Communications sites like360Dx - GenomeWeb - Precision Medicine OnlineTechTarget Group sites likeComputer Weekly - TechTargetThe Chronicle sites likeThe Chronicle of Higher Education - The Chronicle of PhilanthropyEncyclopedia/Book
library/Knowledge baseBBC History Extra - Encyclopedia Britannica - eNotes - Glassdoor - Loeb Classical Library - Philosophy Now - Quora - Scholastic - SlideShare - Study.com (only lessons; no videos)SportsCyclingNews - ESPN USA - RugbyPass - Sports Illustrated - The AthleticMagazines/BlogsGrouped in options:Medium (custom) domains like
(opt-in to custom sites for unlisted)Medium - Better Programming - Towards Data ScienceAl-Monitor - Americas Test Kitchen - American Purpose - Apollo Magazine - Artforum - Artnet - Atavist Magazine - Axios - Blaze Media - Commentary Magazine - Defector - Dwell - Field & Stream - First Things - Foreign Affairs - Foreign Policy - Harpers Magazine
- Jazzwise - National Review - Newsweek - Outdoor Life - Paste Magazine - Pirate Wires - Politico - Project Syndicate - Puck.news - Slate - SofRep - Stereogum - Stratfor - Texas Monthly - The American Conservative - The American Interest - The American Scholar - The Art Newspaper - The Atlantic - The Baffler - The Christian Science Monitor - The
Daily Beast - The Daily Wire - The Diplomat - The Dispatch - The Impression - The Intercept - The Juggernaut - The Lamp Magazine - The Nation - The New Atlantis - The New Criterion - The New Republic - The New York Review of Books - The Point Magazine - The Spectator World - The Week - The Wrap - Vice - Washington ExaminerGrouped in
options:Cond Nast magazines sites likeArchitectural Digest - Bon Apptit - British Vogue - Cond Nast Traveler - Epicurious - GC - The New Yorker - Vanity Fair - Vogue USA - WiredHearst Communications magazines sites likeBicycling - Cosmopolitan - Country Living - Delish - Elle Decor - Elle USA - Esquire - Good Housekeeping - Harpers Bazaar -
House Beautiful - Mens Health - Oprah Daily - Popular Mechanics - Prevention - Road & Track - Runners World - Town & Country - Womens HealthOutside magazines sites likeBackpacker - Beta - Better Nutrition - Clean Eating - Climbing - Outside - Oxygen - SKI - Trail Runner - Triathlete - Vegetarian Times - Womens Running - Yoga JournalPenske
Media Corporation sites likeBillboard - Rolling Stone - Sourcing Journal - Sportico - Variety - WWDThe Epoch Times sites like (opt-in to custom sites for br|cz|de|fr|jp|ro sites)Epoch.org.il - The Epoch TimesVox Media Group sites likeCurbed - Grub Street - New York Magazine - The Cut - The Verge - Vox - VultureLocal USA newsAlbuquerque Journal -
CNN - Fox News - Honolulu Star-Advertiser - Las Vegas Review-Journal - Los Angeles Times - Mountain View Voice - Newsday - Palo Alto Online - Pittsburgh Post Gazette - Star Tribune - Tampa Bay Times - The Atlanta Journal-ConstitutionThe Baltimore Banner - The Boston Globe - The Columbian - The Dallas Morning News - The Hill - The New York
Sun - The Salt Lake Tribune - The San Francisco Standard - The Seattle Times - The Philadelphia InquirerUSA Today Grouped in options:Advance Local sites likeAL/Alabama - MLive/Michigan - NJ/New Jersey - Staten Island Advance - The Express-Times - The Oregonian - The Patriot-News - The Plain Dealer - The Post-Standard - The RepublicanCNHI
Group sites (opt-in to custom sites)Forum Communications sites (opt-in to custom sites)Gannett Group (local USA Today) sites like (opt-in to custom sites for unlisted)Austin American-Statesman - Democrat and Chronicle - Detroit Free Press - Knoxville News Sentinel - Memphis Commercial Appeal - Milwaukee Journal Sentinel - The Arizona Republic -
The Cincinnati Enquirer - The Columbus Dispatch - The Courier-Journal - The Des Moines Register - The Detroit News - The Florida Times-Union - The Indianapolis Star - The News-Press - The Oklahoman - The Record (North Jersey) - The TennesseanHearst Communications (newspapers) sites like (opt-in to custom sites for unlisted)Albany Times
Union - Connecticut Post - Houston Chronicle - New Haven Register - San Antonio Express-News - San Francisco ChronicleLee Enterprises Group sites like (opt-in to custom sites for unlisted)Arizona Daily Star - Lincoln Journal Star - Omaha World-Herald - Richmond Times-Dispatch - St. Louis Post-Dispatch - The Buffalo News - The Times of
Northwest Indiana - Tulsa World - Wisconsin State Journal - Winston-Salem JournalMaine Trust sites (opt-in to custom sites)McClatchy Group sites like (opt-in to custom sites for unlisted)Belleville News-Democrat - E1 Nuevo Herald - Fort Worth Star-Telegram - Lexington Herald-Leader - McClatchy DC - Miami Herald - The Charlotte Observer - The
Fresno Bee - The Kansas City Star - The News & Observer - The Sacramento Bee - The State - The Wichita Eagle - Tri-City HeraldMediaNews Group sites like (opt-in to custom sites for unlisted/local sites)Boston Herald - East Bay Times - Orange County Register - San Diego Union Tribune - St. Paul Pioneer Press - The Denver Post - The Mercury News
- The Press-EnterpriseThe (New Orleans) Advocate Group sites likeThe Advocate - The New Orleans Advocate/The Times-Picayune - The Shreveport-Bossier City AdvocateTownNews sites (Blox CMS) (opt-in to custom sites)Tribune Publishing Company sites likeBaltimore Sun - Capital Gazette - Chicago Tribune - Daily Press - Hartford Courant - New
York Daily News - Orlando Sentinel - SunSentinel - The Morning Call - The Virginian-PilotCanadaiPolitics - Le Devoir - The Globe and Mail - The Hill Times - The Logic - Winnipeg Free PressGrouped in options:Groupe Capitales Mdias sites like (opt-in to custom sites for unlisted)Le SoleilGroupe Qubecor sites likeLe Journal de Montral - Le Journal de
QubecPostmedia Network sites like (opt-in to custom sites for unlisted)Calgary Herald - Financial Post - National Post - The Province - Toronto Sun - Vancouver SunTorStar sites likeThe Toronto Star and regional sites Niagara Falls Review - Peterborough Examiner - St. Catharines Standard - The Hamilton Spectator - Waterloo Region Record -
Welland TribuneValnet Group sites (opt-in to custom sites)EuropeBalkan Insight - Bloomberg Adria - EUobserver - Follow the Money (ftm.eu)United Kingdom/IrelandAutocar - Autosport* - Belfast Telegraph - Business Post - Decanter - Evening Standard - Financial News - Financial Times - GB News - Granta Magazine - iNews - Investors Chronicle -
Irish Independent - Literary Review - London Review of Books - Monocle - Motor Sport Magazine - Prospect Magazine - Stylist - Tes Magazine - The Critic - The Economist - The Irish Examiner - The Irish News - The Irish Times - The Lawyer - The New European - The New Statesman - The Spectator - The Telegraph - The Times - The Times Literary
Supplement - UnHerdGrouped in options:Daily Mail Group sites likeDaily Mail - Mail on Sunday - This is MoneyDVV Media International sites (opt-in to custom sites)Haymarket Media Group sites (opt-in to custom sites)Haymarket Medical Network sites (opt-in to custom sites)National World Publishing sites like (opt-in to custom sites for unlisted)The
Scotsman - Yorkshire PostOxford University Press sites (opt-in to custom sites)*Newsquest Media Group sites (opt-in to custom sites)The Independent Group sites likeThe Independent UK - The Independent USAThe Stage Media sites like:The Bookseller - The StageThe Sun Group sites likeThe Scottish Sun - The Sun UKWilliam Reed Group sites (opt-
in to custom sites)BulgariaCapital - DnevnikCzechiaDenkDenmarkBerlingskeGrouped in options:DK Medier sites (opt-in to custom sites)FinlandSuomen SotilasFrance/Wallonia60 Millions de consommateurs - Actu.fr - Alternatives Economiques - Aoc media - Atlantico - Auto Hebdo - Auto Plus - Capital - Causeur - Challenges - Charlie Hebdo -
Connaissance des Arts - Cosmopolitan - Courrier international - Elle - Esprit - Jeune Afrique - Lcho - Lquipe - LExpress - LInform - LOeil de la Photographie (fr/en) - LOpinion - La Nouvelle Rpublique du Centre-Ouest - Le Courrier des Stratges - Le Figaro - Le Grand Continent - Le Journal du Dimanche - Le Journal du Net - Le Monde - Le Nouvel
Economiste - Le Parisien - Le Point - Le Revenu - Le Tlgramme - Le Un - Les chos - Les Inrockuptibles - Libration - Marianne - Ouest-France - Paris Match - Philonomist (fr/en) - Philosophie Magazine - Politis - Pour lco - Pour la Science - Public - Rforme - Revue Conflits - Science & Vie - Sciences et Avenir - Sciences Humaines - Tlrama - Valeurs
Actuelles - XXIGrouped in options:Groupe Centre France sites like (opt-in to custom sites for unlisted)La MontagneGroupe Infopro Digital sites like (opt-in to custom sites for unlisted)LUsine NouvelleGroupe IPM sites likeDH Les Sports+ - LAvenir - La LibreGroupe La Dpche sites likeCentre Presse - Journal de Millau - LIndpendant - La Dpche du Midi
- La Nouvelle Rpublique des Pyrnes - Le Petit Bleu dAgen - Midi Libre - Midi OlympiqueGroupe Nice-Matin sites likeMonaco-Matin - Nice-Matin - Var-MatinGroupe Profession Sant sites likeLe Quotidien du Mdecin - Le Quotidien du PharmacienGroupe Rossel sites likeLLAisne nouvelle - LArdennais - LEst-clair - LUnion - La Voix du Nord - Le Courrier
picard - Le Messager - Le Soir - Libration Champagne - Nord Littoral - Paris Normandie - SudInfoGroupe Sud Ouest sites likeCharente libre - La Rpublique des Pyrnes - Sud OuestGroupe Syner] Media sites (opt-in to custom sites)Roularta Media Group sites likeFemmes dAujourdhui - Flair.be - Le VifTechTarget Group sites
likeLeMagITGermany/AustriaAachener Zeitung - rzte Zeitung - Automobilwoche - Berliner Zeitung - Bild - Brsen-Zeitung - Der Freitag - Der Spiegel - Der Tagesspiegel - Die Rheinpfalz - Die Welt - Die Zeit - Frankfurter Allgemeine Zeitung - Hamburger Morgenpost - Handelsblatt - Heise online - Jacobin Magazin - Klner Stadt-Anzeiger - Klnische
Rundschau - Krautreporter - Kurier.at - Manager Magazin - Neue Westflische - Nordwest Zeitung - Philosophie Magazin - Pigd - Profil.at - Spektrum - Springer Medizin - Stern - Sddeutsche Zeitung - Sdkurier - T3n - Tiroler Tageszeitung - Vorarlberg Nachrichten - Vorarlberg Online - Weltkunst - Weser-KurierGrouped in options:Deutscher Fachverlag
Mediengruppe (opt-in to custom sites)Funke Mediengruppe sites likeBerliner Morgenpost - Braunschweiger Zeitung - Hamburger Abendblatt - Iserlohner Kreisanzeiger und Zeitung - Neue Ruhr Zeitung - Ostthringer Zeitung - Thringer Allgemeine - Thringische Landeszeitung - Westdeutsche Allgemeine Zeitung - Westfalenpost - Westflische
RundschauHaas Mediengruppe sites like (opt-in to custom sites for unlisted)Mannheimer Morgenlppen.media sites like (opt-in to custom sites for unlisted)Frankfurter Rundschau - Mnchner Merkur - Oberbayerisches VolksblattLandwirtschaftsverlag sites likeProfi.de - Top Agrar - Wochenblatt fr Landwirtschaft & LandlebenMadsack Mediengruppe
sites like (opt-in to custom sites for unlisted)Hannoversche Allgemeine Zeitung - Kieler Nachrichten - Leipziger Volkszeitung - Lbecker Nachrichten - Mrkische Allgemeine - Neue Presse (Hannover) - Ostsee-Zeitung - RedaktionsNetzwerk Deutschland - Schsische ZeitungMedia Group Westfalen sites like (opt-in to custom sites for unlisted)Ruhr
NachrichtenMotor Presse Stuttgart sites likeAerokurier - Auto Motor und Sport - Flug Revue - Motorrad - Womens HealthNOZ/MHN Mediengruppe sites likeNeue Osnabrcker Zeitung - Schleswig-Holsteinischer Zeitungsverlag Rheinische Post Mediengruppe likeGeneral-Anzeiger Bonn - Rheinische Post - Saarbrcker Zeitung - Trierischer
VolksfreundVerlagsgruppe Rhein Main sites like (opt-in to custom sites for unlisted)Allgemeine Zeitung (Mainz) - Darmstdter Echo - Wiesbadener KurierGreeceKathimeriniltalyCorriere della Sera - Corriere dello Sport - Domani - Eastwest - Il Fatto Quotidiano* - Il Foglio - Il Manifesto - Il Sole 24 Ore (24+) - Internazionale - Italia Oggi - La Gazzetta
dello Sport - Milano Finanza - Sky Sport - Sky TG24 - TuttosportGrouped in options:Gruppo GEDL.it sites likeHuffingtonpost.it - Italian.tech - La Repubblica - La Stampa - Le Scienze - Moda & Beautyll Messaggero and regional sites like Corriere Adriatico - I1 Gazzettino - Il Mattino - Quotidiano di PugliaQuotidiano Nazionale and regional sites like I1
Giorno - Il Resto del Carlino - Il Telegrafo Livorno - La NazioneGruppo SAE.it* sites like (opt-in to custom sites for unlisted)Il Tirreno* - La Nuova Sardegna*Netherlands/FlandersBusiness AM - Business Insider Nederland - De Tijd - Doorbraak - Follow the Money - Groene Amsterdammer - Het Laatste Nieuws - Linda - NRC Handelsblad - Telegraaf -
Vrij NederlandGrouped in options:Algemeen Dagblad (+ regional/ADR) sites likeAlgemeen Dagblad - BN DeStem - Brabants Dagblad - Eindhovens Dagblad - Gelderlander - PZC - Stentor - TubantiaDPG Media (not ADR) sites likeDe Morgen - De Volkskrant - Flair.nl - Humo - Libelle.nl - Margriet - Parool - TrouwMediahuis Belgi sites likeDe Standaard -
Gazet van Antwerpen - Het Belang van Limburg - Het NieuwsbladMediahuis Nederland Regional sites like (opt-in to custom sites for unlisted)De Limburger - Noordhollands Dagblad - Haarlems Dagblad - Leidsch DagbladMediahuis Noord sites like (opt-in to custom sites for unlisted)Dagblad van het Noorden - Leeuwarder CourantProMedia Group
sites (opt-in to custom sites)Roularta Media Group sites likeArtsenkrant - Beleggers Belangen - Flair.be - Knack - Krant van West-Vlaanderen - Libelle.beNorwayBergens Tidende - Dagsavisen Grouped in options:DN Media Group sites likeDN - Europower - Fiskeribladet - Hydrogen Insight - Intrafish - Intrafish.no - Recharge - TradeWinds -
UpstreamPolandPolityka - Puls Biznesu - TVN24Grouped in options:GremiMedia.pl Group sites likeParkiet - RzeczpospolitaRingier Axel Springer Polska sites likeAuto Swiat - Business Insider - Forbes - Komputer Swiat - Newsweek - OnetWyborcza Group sites likeMagazyn-kuchnia.pl - Wyborcza.biz - Wyborcza.pl - Wysokieobcasy.plPortugalDirio de
Notcias - Expresso - Observador - SbadoRussiaWonderzineSpainDiario de Navarra - El Confidencial - El Diario.es - El Espaol - El Pas - InfoLibre - La Vanguardia - Mundo Deportivo - Poltica Exterior - PblicoGrouped in options:ARA sites likeAra.cat - Ara BalearsGrupo Prensa Ibrica sites like (opt-in to custom sites for unlisted)Diario de Mallorca - El Da -
El Peridico de Catalunya - El Peridico de Espaa - Faro de Vigo - Informacin - La Nueva Espaa - La Provincia - Levante-EMV - Mallorca Zeitung - SuperdeporteGrupo Unidad Editorial sites likeEl Mundo - Expansin - MarcaGrupo Vocento sites likeABC - Canarias? - El Comercio - El Correo - El Diario Montas - El Diario Vasco - El Norte de Castilla - Hoy -
Ideal - La Rioja - La Verdad - La Voz de Cdiz - Las Provincias - SurSport Life Ibrica sites (opt-in to custom sites)SwedenDagens ETC - NyTeknikGrouped in options:Bonnier News Group sites like (opt-in to custom sites for unlisted)Dagens Medicin - Dagens Nyheter - Helsingborgs Dagblad - SydsvenskanNWT Media sites (opt-in to custom
sites)SwitzerlandNeue Zrcher Zeitung - Schweizer Monat - The MarketGrouped in options:CH Media sites like (opt-in to custom sites for unlisted)Aargauer Zeitung - Luzerner Zeitung - St. Galler TagblattGroupe ESH Mdias sites likeArcInfo - La Cte - Le NouvellisteRingier Gruppe sites likeBlick - Beobachter - HandelszeitungTAmedia sites like (opt-in
to custom sites for unlisted)24 heures - Basler Zeitung - Berner Zeitung - Der Bund - Tages-Anzeiger - Tribune de GenveUkraineForbes - New VoiceAfricaKenyaThe StandardGrouped in options:Nation Media Group sites like (opt-in to custom sites for unlisted)Business Daily - Daily NationAustralia/New ZealandBusinessDesk - Forbes Australia - Inkl -
MacroBusiness - New Zealand Herald - The Saturday Paper - The Spectator Australia - The West Australian (4 regional/opt-in to custom sites)Grouped in options:Australia News Corp sites likeCairns Post - Code Sports - Geelong Advertiser - Gold Coast Bulletin - Herald Sun - The Advertiser/AdelaideNow - The Australian - The Chronicle - The Courier-
Mail - The Daily Telegraph - The Mercury Tasmania - The Weekly Times - Townsville BulletinAustralia Nine Entertainment sites likeBrisbane Times - The Age - The Australian Financial Review - The Sydney Morning Herald - WAtodayAustralian Community Media sites like (opt-in to custom sites for unlisted)Bendigo Advertiser - Central Western Daily -
Daily Liberal - Illawarra Mercury - Newcastle Herald - The Advocate - The Border Mail - The Canberra Times - The Courier - The Daily Advertiser - The Examiner - The Northern Daily Leader - The Standard - Western AdvocateMcPherson Media Group sites (opt-in to custom sites)Private Media sites likeCrikey - Smart Company - The MandarinChina,
Hong Kong & TaiwanCommonWealth Magazine Taiwan* - DigiTimes Asia - South China Morning Post - Southern Weekly - The News LensIndiaBar and Bench - Bhaskar - Business Standard - Hindustan Times - Inc42 - India Today - Live Law - LiveMint - Malayala Manorama - Mid-Day - Newslaundry - NDTV Profit - Outlook - Outlook Business -
Swarajyamag - The Economic Times (ET Prime) - The Financial Express - The Hindu - The Hindu BusinessLine - The Indian Express - The Leaflet - The News Minute - The Quint - Times of India - VikatanIndonesiaKompasIsraelGlobes - The Jerusalem Post - YnetGrouped in options:Haaretz Group sites likeHaaretz.co.il - Haaretz.com - The
MarkerJapanBusiness Insider Japan - Mainichi Shimbun - Nikkei Asian Review - The Japan TimesSingaporelnitium Media - Tech in Asia Grouped in options:SPH Media sites likeThe Business Times - The Straits TimesLatin AmericaArgentinambito - El Cronista - El Tribuno - La Gaceta - La Nacin*Grouped in options:Grupo Clarn sites likeClarn - La Voz
del Interior - Los Andes - OlBoliviaEl DeberBrazilABC Mais - CartaCapital - Correio do Povo - Cruso - Estado de Minas - Exame - GachaZH - Gazeta do Povo - Grupo Abril - Le Monde Diplomatique Brasil - NSC Total - O Estado de S. Paulo - O Globo - Revista Oeste - Valor EconmicoGrouped in options:UOL sites likeFolha de S. Paulo - UOLChileDiario
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